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Or as we commonly say – do over! I guess that's one thing about computers in that do overs are not only
possible, but frequent. In fact, I'd say they are encouraged. Look how Apple has built in the command-
Z undo into iWork down several levels. I don't think I've ever "hit bottom". As my brother-inlaw
Manhattan College professor would say, "The problemwith computers in writing a paper or book is that
you're never really finished 'til the presentation is over or the book is published. The computer just begs
you to make last second tweaks, it's too easy." Ohhhh, where do we stop?

So, in that sense, David and I don't feel so bad about the effort last month to get "our" iPad andAppleTV
upandrunning.Thismonth, thingswill bedifferent.Onceagain,we're callingeveryone tobring their iPad,
iPhone and even your lap top to the meeting. With everything hooked up properly, each one of you can
be a "60 second" presenter through AirPlay. Oh yes, you'll have to be on iOS7 or Mountain Lion or
Mavericks on the laptop.

You may wonder why things will work this month. Well, David and I got together. We evaluated the
problem and did some test runs. Come to the meeting and we'll show you how it's done.

Remember - 2ndSaturdayof themonth - January 11th - atVoorheesHighSchool justnorthofHighBridge,
NJ. The public is welcome. Enjoy our gourmet donuts, bagels and coffee.
See you soon.

Bill Barr

The iPad / AppleTV Refaire -



Using Tabs in the Mavericks
Finder
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by Adam C. Engst

One of the marquee changes in OSX 10.9Mavericks is
the addition of tabbed windows to the Finder, bringing to
file organization andmanipulation the flexibility we’ve be-
come accustomed to in Web browsers and other apps.
Each tab stands in for a window, displaying the files and
folder in a specific spot on one of your mounted volumes.
If youoftenhavemultipleFinderwindows litteringupyour
Desktop, tabbed Finder windows may be just what you
need.

Luckily, Apple implemented Finder tabs in nearly the
same way as Safari tabs, making usage generally familiar,
though users of otherWebbrowsersmaywish to do a little
remappingof keyboard shortcuts usingKeyboardMaestro
[http://www.keyboardmaestro.com/] or a similar utility.

There is one setting you need to make sure is enabled
before proceeding, since it causes a number of the com-
mandandkeyboardshortcutsbelowtoworkdifferently. In
Finder >Preferences >General,make sure to select “Open
folders in tabs instead of newwindows.” (This replaces the
old “Always open folders in a new window,” and if you
prefer towork in numerouswindows rather than tabs, des-
elect this option and check the comments for some usage
tips.)

With that done, here’s
a quick look at how to use
tabs.

Hide and Show the
Tab Bar -- In a Finder
windowwith only one tab,
press Command-Shift-T
to show or hide the tab
bar. I can’t see peoplewho
rely on tabs using this much, except to simplify single-tab
windows for screenshots.

Alongwith some readers, I’m a little sad that this short-
cut doesn’t reopen the last closed tab, as it does in Google
Chrome and Firefox. But in Safari, Apple oddly mapped
that function toCommand-Z, theuniversalUndo, anddid-
n’t see fit to bring the capability to the tabbed Finder.

Create Tabs -- You can open new tabs in a variety of
ways. As far as I can tell, each new tab honors the view and
sort settings associated with the folder being opened, so
one tab might automatically open in list view, sorted by
date modified, whereas another might open in column
view, sorted by name.

PressCommand-T (File >NewTab) to open a new
Finder tab, displaying the contents of the folder selected in
Finder > Preferences > General > New Finder Windows
Show. If you’re mousing anyway, you could instead click
the + button on the right side of the tab bar.OrControl- or
right-click any tab in the tabbar and chooseNewTab from
the contextual menu that appears.

( continues )
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Select a folder in a window (not on the Desktop) and
press Control-Command-O (File > Open in New
Tab). Or Control-click the folder and choose Open in
New Tab. Or select it and choose Open in New Tab from
theActionmenu in thewindow’s toolbar.You get the con-
cept.

Command-click any folder in the sidebar to open
it in anewtab. Frankly, I think this will end up being my
go-to shortcut, since my most frequently accessed folders
are already in the sidebar. It’s easier than Control-clicking
a folder in the sidebar andchoosingOpen inNewTab from
the contextual menu.

Command-double-click a folder to open it in a
newtab.While this initially seems like aneat shortcut, it’s
actually quite awkward, for two reasons.

If you’re in column view, with nothing selected, the first
of the two clicks selects the folder in the current tab, and
the second click opens it in a new tab, giving you two tabs
for the same folder. That doesn’t seem particularly useful;
perhapsApplecould switch theviewtoanexisting instance
of a tab rather than create two identical tabs in the same
window.

In any view, if youhave a file or folder selectedbefore you
Command-double-click the folder youwant to open, you’ll
get a new tab for the desired folder, but you’ll also get new
tabs for other selected folders, and any files that were se-
lected will open too, just as if you’d double-clicked them
(which you did). This often results in confusion, but it can
be helpful— select a couple of folders andCommand-dou-
ble-click them to open all of them in new tabs.

Apple’s goal here is undoubtedly to mimic the Com-
mand-click shortcut inWeb browsers, but that can’t work
in the Finder, where a Command-click is used for discon-
tiguous selection. I’m not sure Command-double-click is
sufficiently successful that I’ll end up using it much.

MoveBetweenTabs --Themost obviousway tomove
between tabs is of course to click thedesired tab.However,
moving between them with the keyboard will likely be
more efficient formany of us, especially those accustomed

to navigating Web browser tabs from the keyboard.

Control-Tab (Window > Show Next Tab) makes
the next tab to the right active, and Control-Shift-Tab
(Window > Show Previous Tab)moves to the previous tab
to the left.

Although they’re not visible in the interface anywhere,
the Command-Shift-[ and Command-Shift-]keyboard
shortcuts that work in Safari also move left and right
between Finder tabs.

Personally, I use Command-Shift-left/right arrow
shortcuts in all my apps (remapped universally via
KeyboardMaestro) to switchbetween tabs. I believe those
keyboard shortcuts came fromSafari originally (where they
still work), although it too now advertises theControl-Tab
andControl-Shift-Tab shortcuts. ForGoogleChrome and
Firefox, which prefer Command-Option-arrows, I remap
their shortcuts to Command-Shift-arrows. I’ve now used
Keyboard Maestro to bend the Finder’s tab-navigation
shortcuts to my will too. <insert evil laugh here>

Close Tabs -- You won’t have any trouble in this
department.

The File > Close Window command and its associated
Command-W shortcut automatically change to File >
Close Tab when the frontmost Finder window has more
than one tab showing.

If you’remouse-focused, you can click the littleXbutton
that appears when yourmouse pointer hovers over the tab.
If you pressOptionwhen clicking that button, the current
tab stays open and all the other tabs in that window close.

For a mouse-keyboard combination, Control-click the
tab you want to close and choose Close Tab from the
contextualmenu.Again, youcanreverseyourapproachand
Control-click the tab you want to keep open and choose
Close Other Tabs.

TabsandWindows --Therewill undoubtedly be times
when you’ll find yourself with a slew (that’s the technical
term) of Finder windows strewn around your screen. One

Tabs in Mavericks Finder



The opposite action is possible too— chooseWindow >
Move Tab toNewWindow to break a tab out into its own
window. You can also do this by Control-clicking a tab in
the tab bar and choosingMove Tab toNewWindow from
the contextual menu.

If you find that a tab isn’t in the spot youwant on the tab
bar, drag it to a different location. I won’t know until I’ve
had more time withMavericks, but I foresee that I’ll have
exactly the same tabs open all the time, in a precise order,
so I’ll alwaysknowwhere to click for aparticular set of files.

Once you’re dragging tabs around, you may also be
interested tonote that you candrag a taboff awindow’s tab
bar to turn it into a new window, or you can drag it to the
tab bar of another window to add it to that one.

WorkingwithTabs -- All this opening and closing of
tabs may be fun, but the real advantage comes when you
want to move files and folders between locations in the
Finder. No longer do you have to open multiple windows
just to have an easy drag target.

Tabs work like a cross between windows and spring-
loadedfolders, soyoucanmove files andfoldersbydragging
them from one tab’s listing directly to another tab on the
tab bar. If youwant to drop into a folderwithin a tab, pause
briefly on the destination tab until it opens, and then drop
in the desired folder.

All the standard Finder keyboard shortcuts work when
dragging files between tabs, so you can hold down Option
to copy instead of moving within a volume, Command to
move between volumes (copy and delete), and Command-
Option to make an alias in the destination.
Unless otherwise noted, this article is copyright © 2013 TidBITS
Publishing, Inc.. TidBITS is copyright © 2008TidBITSPublishing Inc.
Reuse governed by this Creative Commons License: http://
tidbits.com/terms/.
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quick way to clean them all up is to choose Window >
Merge All Windows, which does exactly what you’d ex-
pect.



PBS and Yahoo Screen have joined the Apple TV
lineup, adding even more content to Apple’s streaming
content device for viewers in theUnited States. Both apps
should appear automatically in theAppleTV’smainmenu
and are free.

YahooScreen features clips fromSaturdayNightLive,
the Daily Show, the Colbert Report, ABC News, The
Onion, and Yahoo original programming. Clips from the
first three showswere already available from theHulu app,
but the last three are new additions. I’m particularly
excited to see the Onion on Apple TV.

The PBS app, like its iOS counterpart, offers up
broadcast shows a few hours after airing. Sadly, like the
HBO, Disney, and ESPN apps, you have to go through an
aggravating activation process to watch PBS.

To activate the PBS app, open it from themainmenu,
and select Activate Your Apple TV. You’re then given an
activation code, which you must enter at http://pbs.org/
activate.

Volume 29, Number 1 www.macnj.org page 5

MACNJ Serving the Central New Jersey Macintosh Community since 1986 September 2013MACNJ Serving the Central New Jersey Macintosh community since 1986 January 2014

( continues )

PBS and Yahoo Come to Apple TV
by Josh Centers
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When I set upmyAppleTV, Iwas told that activation
failed, but after restarting the app, it worked just fine.
However, connectivity is spotty, apparently due to high
demand.

WhatAbout “DowntonAbbey”?

I realize you’re champing at the bit to know if you
can watch “Downton Abbey” on your Apple TV now.
Currently, Amazon has exclusive rights to stream the
popular period drama, which became possible to watch
on the Apple TV only recently, when Amazon added
AirPlay support to its Instant Video iOS app.

Fortunately, there’s a loophole: PBS can stream the
episodes it’s currently broadcasting. As of this writing,
that’s only a single episode, but according to All Things D,
PBS stations will be re-airing the second and third seasons
in December, as well as the fourth season in January, with
the episodes being available for a limited time after the
broadcast. So set your calendar and keep your eyes on your
Apple TV!

Unless otherwise noted, this article is copyright © 2013
TidBITSPublishing, Inc.. TidBITS is copyright©2008TidBITS
Publishing Inc. Reuse governed by this Creative Commons
License: http://tidbits.com/terms/.
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The Flex is the latest
fitness monitoring product
from Fitbit with an inter-
changeablewrist strapaswell
as water resistant electronics
than may be worn in the
shower or anywhere with
brief contact with water.
These features, however come at a price of reduced func-
tionality compared with the One or Ultra and is more like
the lower end Fitbit Zip.

TheFlexuses the same iOSAppanddashboard as the
other Fitbit products and can be synced via a USB dongle
or directly to your Bluetooth 4.0 iPhone or iPad but does
not have a digital display. To see the actual steps you’ve
taken for the day, you’ll need to use the app or view your
progress on the Fitbit website. A series of 5 dots on the
Flex tells you how far you’ve made progress towards your
goal throughout the day (Five solid dots indicate you’ve
met your goal). Without that display you also lose the
stopwatch function,whichwas a very important part ofmy
workouts.

The Flex does not
measure stairs, unlike the
Ultra or One, but does
measure sleep and pro-
vides a vibrating wake up
alarm and sleep quality
monitoring. It seems to
sit slightly above the Zip
but slightly below the

One in the product line (though pricing is the same as the
One). Also because you wear it on your wrist, it didn’t
register movement on an elliptical trainer, but when I put
it in my pocket it worked fine.

All Fitbits feature the ability to compete with your
friends to get in a certain number of steps each day
regardless of which Fitbit product they have. If you
are motivated by gamification, this is the product to
help with your fitness goals. Fitbits also include a basic
food diary for tracking calories, but the third party
API’s help extend this feature such as through the Lose
It app. The device charges via a USB dongle (but not the
same one that enables syncing)

Hardware Review: Fitbit Flex
by Dave Greenbaum
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I’ll admit I was first very disappointed with the
Flex’s inability to provide immediate readout and track
stairs, but I gave up my obsession with knowing the
exact number of steps and became satisfied accepting
the simple progress bar on the device. Not having to
worry about my Fitbit going through the washing
machine and leaving it at home is a strong selling point
even with a lack of features. As I wore it, others
noticed and I was able to increase the number of people
I competed with in the program.

A solid and reliable addition to the Fitbit product
line to motivate you to stay fit.

Pros: Wear it on your wrist and not worry about
water damage or loss, competition among friends
Cons: Doesn’t track elliptical motion, lack of digital
readout

Five out of Five Dogcows

Originally published and written for the Lawrence
Apple Users' Group 2.0 http:// www.laugks.org/news and
published by Dave Greenbaum at

http:www.clickheretech.com_._,_.___

I thought thatmy annual Thanksgiving trip to visit my
brother andsister-in-lawwouldbe theperfect time towrite
an article. But, rather than haul my aging MacBook along
on the trip, I decided to compose the article on my sleek
new iPad Air. As luck would have it, a review unit of
Belkin’s QODE Ultimate Keyboard Case for iPad Air
( www.belkin.com/us/ ) arrived at my door five minutes
before the airport shuttle arrived, giving me just enough
time to shove the unopened package into my carry-on bag
before embarking on my journey.

When I arrived at my brother’s home, I unpacked the
case and, using the included meter-long USB-to-micro-
USBcable, plugged it intomy iPad’s charger.Thecasemust
have been pre-charged at the factory, because less than ten
minutes later, thecharging lightonthe right sideof thecase
indicated that the battery was full.

Meanwhile, I examined thepackaging for amanual.All
I could find was a single card-stock sheet with minimalist
instructional diagrams labeled in English, French, and
Spanish. Even those instructions were unnecessary, as it

Belkin Ultimate Keyboard Case Makes
iPad Air a Fair Travel Computer

byMichael E. Cohen

Fitbit Flex continued from page 6
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was obvious how to snap the iPad into the case, and I
had already figured out how to charge the device. What I
didn’t know was how to turn the case on or how to pair its
Bluetooth radio with my iPad Air.

The answer to the first
question is simple: once
the iPad is in place, awake,
andpositioned for use, the
case comes to life
automatically. As for the
secondquestion, that, too,
almost answers itself: you
hold down the Fn key at
the lower-left of the
keyboard while tapping
the Pair key at the upper-
right. Pairing happens
almost instantly, and
doesn’t require typing a
pairing code (though you
do, of course, have to
remember to turn on
Bluetooth in the iPad’s
Settings app). A blue light illuminates briefly to let you
know that pairing has taken place.

Snapping the iPad into the case is easy: cut-outs around
the edge of the case line up with the iPad’s ports and
buttons so you can do it even in the dark. The iPad snaps in
so securely that it’s harder to get the iPad out than to put
it in!That’s a goodthing,of course, sinceyoudon’twant the
iPad to pop out accidentally. However, it took me a few
tries toworkout theeasiestway toconvince thecase togive
me my iPad back— I recommend you place the case on a
flat surface first before you try popping the iPad out so you
don’t send your precious tablet flying through space.

Although you have complete access to the iPad’s
ports and buttons when the iPad is in place, the only
ones you are likely to need are the Sleep/Wake button,
headphone jack, and Lightning cable socket. The
keyboard itself has a dedicated key for the iPad’s Home
button, along with function keys (invoked when you hold
down the Fn key) for controlling audio volume, muting,

playing and pausing media, showing and hiding the on-
screen keyboard, and even one for displaying the multi-
tasking screen. When the iPad is sleeping, a quick tap of
the Home key on the keyboard wakes it.

There are also function keys for cut, copy, and paste,
though you may not have
touse them: thekeyboard
includes both standard
Command and Option
keys that worked with
every text editing app I
tried, so I didn’t have to
retrain my fingers for
common editing
maneuvers. The same,
unfortunately, cannot be
said about touch-typing;
the semicolon key is
placed just to the right of
the space bar instead of at
its usual location to the
right of the L key, so I
found myself hitting the
apostrophe key whenever
I wanted a colon or

semicolon. Also, the apostrophe key is narrower than the
other keys, so even when I remembered its non-standard
location, I often overshot it and pressed Return instead.

However, these are relatively minor quibbles. Aside
from the half-size apostrophe key, I found the keyboard
large enough to fit my hands, and the keys themselves
provided a similar tactile response to those built into my
MacBook. You won’t mistake the keyboard for a classic
IBM Selectric typewriter, but it more than serves the
purpose.

Physically, the case is rather sturdy. The bottom is
aluminum, protecting both the keyboard and the iPad
screen when the case is closed. The top frame, where the
iPad snaps in, is rigid plasticwith an imitation leather panel
and amicro-fiber lining that protects the back of the iPad.
The top frame attaches to the keyboard by that panel,
which unfolds to act as a stand so you can angle the iPad
when it is in use. You can flip the top frame around to hold
the iPad one-handed, though that leaves the keys exposed
on the back. ( continues )

Belkin continued from page 7
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Whenopen, the top frameholds the iPad inplacewith
magnets; thin lines printed above the keyboard show
where to align the top frame with the bottom, and there
are three sets of them so you can adjust the viewing angle
to your liking. The magnets also hold the case closed se-
curely— I found that opening the case requiredmore than
a casual amount of force. Again, this is a good thing, since
it keeps the case from opening accidentally.

The case by itself is somewhat heavier than the iPad
Air — Belkin does not provide specs but, according to
Amazon, the case weighs 1.3 pounds (590 grams), making
the combined case and iPad Air just slightly heavier than,
say, a third-generation iPad with a Smart Cover. That’s
certainly not unbearable, but it’s not an arrangement you
would use for extended periods of pleasure reading. You’ll
probably want to free the iPad Air from its case when you
curl up with a good ebook.

Duringmyweekofwriting, I experienceda fewglitches.
Several times I had key presses go mad and repeat them-
selves until I tapped another key.Twice the keyboard sud-
denly became completely unresponsive; to cure that I put
the iPad to sleep and then woke it up again, which re-
established the Bluetooth connection. But those glitches
were rare and hardly interfered with my work.

Battery life is exceptional: I haven’t recharged it since
I gave it its initial charge. Belkin states that the case can
operate for 264 hours (about a month of 8-hour days) on a
charge, and it can hold a charge on standby for about six
months. I have come nowhere near either of those limits.
Even heavy users of the case should not have to charge it

more than once every couple of months.

At $129, Belkin’s QODE Ultimate Keyboard Case for
iPadAir ispricey, butnotoverpriced: it’s lightweight, stur-
dy, and very easy to set up and use. It may not turn your
iPad Air into a MacBook Air, but it does make your
lightweight tablet a practical alternative to aMacBook for
many tasks.

Unless otherwise noted, this article is copyright © 2013 Tid-
BITS Publishing, Inc.. TidBITS is copyright © 2008 TidBITS
Publishing Inc. Reuse governed by this Creative Commons
License: http://tidbits.com/terms/.

Belkin continued from page 8
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Dave and Bill began with an effort to set up Airplay to allow other members in the Club to share the new Club
iPad on their iPhones or iPads. In setting up the Apple TV, there was trouble with the password, and they could
not set up Home Sharing.

Bill then discussed the Go Pro camera, touted as the world’s most versatile camera, which can be equipped with a
variety of mounts to obtain video and stills.

Dave then explained the acquisition of the new Club iPad Air which started out as 16 GB with 12 apps; when he
found it was using too much memory, he returned it to the Apple Store and upgraded to the 32 GB version. The
purchase of other ancillary equipment brought the total expended from the Club treasury to $854.37. If the bank
balance goes below $3,000, it may be necessary to change banks to avoid monthly service charges.

Dave advertised that there are two computers for sale - a 27” iMac and a MacBook Pro. If interested, contact Dave
Kemp at 908-439-2152. He also mentioned a free software trial available for photos that was described in an email
and on the Forum.

Chod Lang stated that Canvas Essentials is back: find out about it on tuts plus.

The meeting was opened to Q & A. Bill opened with the rhetorical question -Why did the new Pages
application eliminate the Mail Merge feature? Sheila Barnes is worried about losing graphics applications if she
upgrades to a new operating system. She will need a newer processor; Chod discussed with her some of her
possibilities. Dave uses iStudio for the MACNJWindow.

Dave asked members how they handle documents. Lee Roth sends documents from his iPad by email to his
computer. PDF is the preferred save form, but it cannot be edited without a program; however, a copy can be
scanned and then edited. Dave then asked members how they use their iPads. Chod Lang communicates with
friends using Evernote for sharing. He also stated that he built a scanner which uses an iPad or iPhone and
recommends Printer Pro to connect to wireless printers. Chod has a keyboard which is part of the case for his
iPad, and Doris Kiziah has a keyboard made by Logitech which attaches magnetically to the iPad and also serves as
an easel. Lee Roth uses his iPad while traveling, for email, for reference, for the Google Earth application, as a
word processor, Hunterdon Harmonizers files, legal applications, and magazines from iBooks. He has the
cellular version of IPad. Stan Menscher uses his iPad for Bible study. Dave found that the iPad battery has an 11
hour life.

Discussion then turned to handling of photos. A lightning connector is used between iPad or iPhone and
computer. Lee Roth has connectors he purchased in the Apple Store.Lee and Stan recommend manual selection of
photos. Chod loads photos on Photostream, then provides a link for others to download the photos. Preferences
for sharing also include Evernote and Dropbox.

Chod again recommended the Square card reader for business transactions. The method for taking screen shots
with an iPad was described - it requires operation of the Power and Home buttons.

The meeting was concluded with a Keynote presentation by Bill Barr which was a video describing liquid
sampling equipment.

by Hugh Murphy, Jr.
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Organize Receipts on Your iPhone
with Receiptmate by Chris Armstrong

Keeping track of receipts is an infuriating task in the
digital age.Whether you track them for reimbursement by
your employer or to better watch your personal finances,
managing a flurry of small receipts is a headache. Nobody
wants to sort through a filing cabinet filled with little bits
of paper or trudge through the data entry necessary to gen-
erate an expense report.

Fortunately, I’m not the only person with a vendetta
against physical receipts.Gareth duPlooy, themanbehind
Brilliantish Software [ http://www.brilliantish.com/], has
created Receiptmate for iPhone [https://itunes.apple.-
com/u s / app / r e ce ip tmate - s c an -you r - r e ce ip t s /
id668694949?mt=8&at=10l5PW], a $2.99 app to scan your
receipts, tally up their totals, and store themdigitally in the
snippet-keeping service Evernote [https://evernote.com/].
UsingEvernote for storage rather than yet another custom
service is sensible— having all my receipts accessible from
any device with the Evernote app is an appealing proposi-
tion— plus Evernote is tried and tested for PDF storage.
You will need an Evernote account to use Receiptmate

Receiptmate is flexible, allowing you to add receipts
anytime. Prefer to snap pictures of your receipts
throughout thedayandadd themto theapp in theevening?
No problem, as it can import images from your iPhone's
Camera Roll. Would you rather add each receipt as you
receive it? Receiptmate works well in that case too, since
the interface allows quick entry. Here's the basic process.

Entering Receipts and Amounts -- Receiptmate
uses your iPhone’s camera to scan receipts: it’s just one tap
away from the app’s main screen, letting you quickly snap
a picture of a receipt or import an existing image fromyour
camera roll. Next, you must crop the receipt's image,
removing cruft around the edges. Then, Receiptmate
automatically adjusts brightness and contrast, preparing
the image for you to highlight the total.

( continues )
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continued from page 11
The main reason to keep receipts is to track spending amounts, so the next step is enter the amount of your scanned
receipt. Receiptmate prompts you to highlight the total with a finger, after which the built-in text recognition engine
takes its best guess at the amount. I've had mixed results with this feature, but corrections are easy: just tap out the
amount— no need to delete the bad guess.

Finally, you can add additional pages to the receipt
— a feature I have yet to need. Each page you add
follows the same process described above. Once
you're satisfied with the end result, enter a title and
any notes you may have, and you’re done.

The finished receipt uploads to Evernote in the background. I made a new notebook in Evernote called
Receipts and directed all my Receiptmate uploads there to keep them separate from the rest of my notes.

Once you have sufficient data within Receiptmate, it’s easy to generate spending reports right within the app,
which you can then export as either a PDF or an Excel spreadsheet.

( continues )

Receiptmate
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continued from page 12Receiptmate
Receiptmate’s settings menu contains options to change the active

Evernote account, choose the default Evernote notebook to save receipts
to, enable or disable tags, turn on the saving of location information to
your receipts and— one of my favourite features— support for custom
input fields. These fields use the same text recognition as the amount
calculator described earlier, but they can be named anything youwish and
be given units varying from currencies to distances.

TheFuture, forReceiptmate andYou --Themain place where
Receiptmate could improve is with its text recognition. The success-to-
failure ratio just isn't goodenough, to thepointwhere I simplydon't trust
it. Worse, recognition problems occasionally arise from the automatic
contrast and brightness adjustments Receiptmate itself makes. The
smartdesigndecision toallowmanual entry if recognition fails lessens the
annoyance, but I’d rather see the text recognition removed entirely. Plus,
it can be frustrating when the automatic brightness and contrast
adjustments render the receipt difficult to read, so I hope to see either
some improvements to these adjustments or more manual contrast
control in a future update.

What if you want to stop using Receiptmate or Evernote in the
future? Exporting all your receipts from Evernote is easy: all you would
lose are the amounts entered manually or by text recognition, and since
the amounts storedwithinReceiptmate are used to generate reports, you
can create one final Excel spreadsheet with all your receipt data. This
shouldmakemoving relatively painless. The scanned receipts are easy to
work with as well, since they're all named and dated in Evernote.

Making the leap to paperless can be psychologically wearing, due to
worries about potential problems that might offset promised benefits.
But if physical receipts are a pain point and you already use Evernote for
online storage of documents, Receiptmate is worth investigating.

The ideal Receiptmate user would be an individual just starting out
in the paperless world and looking to track expenditures for personal
reasons — if your employer requires you to submit expense reports in
specific formats or enter receipts into an invoice management system,
Receiptmatemay notmeet your needs.However, for those of us who are
just looking to do somethingwith our receipts rather than throwing them
out or letting them pile up, Receiptmate's simplicity and focus are
compelling.

Unless otherwise noted, this article is copyright © 2013 TidBITS
Publishing, Inc.. TidBITS is copyright © 2008 TidBITS Publishing Inc. Reuse
governed by this Creative Commons License: http://tidbits.com/terms/.
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